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1 Εγκατάσταση του Octave 

1.1 Αρχεία εγκατάστασης 

Το αρχείο εγκατάστασης του Octave βρίσκεται στην ιστοσελίδα του προγράμματος 

https://www.gnu.org/software/octave/ 

Για ταχύτερο «κατέβασμα» υπάρχει και στον ftp server του Πολυτεχνείου 

ftp.ntua.gr/mirror/gnu/octave/windows/ 

Διαλέγετε το αρχείο εγκατάστασης της πιο πρόσφατης έκδοσης, π.χ.  

octave-4.2.1-w64-installer.exe    ή    octave-4.2.1-w32-installer.exe 

ανάλογα με το αν το λειτουργικό σας σύστημα είναι 64-bit ή 32-bit (ΣΗΜΕΙΩΣΗ: Μπορείτε να το βρείτε από την 

Έναρξη->Υπολογιστής (δεξί κλικ) -> Ιδιότητες). 

1.2 Διαδικασία εγκατάσταση 

Αφού ολοκληρωθεί το download του αρχείου εγκατάστασης ξεκινά η εγκατάσταση του προγράμματος. Στα επόμενα 

παράθυρα που θα εμφανιστούν επιλέξτε Next>  και τέλος Install. 

 

 

 

 

 

 

Εάν εμφανιστεί ένα μήνυμα σχετικά με τις Java libraries, όπως φαίνεται παρακάνω, 

πατήστε Yes για να συνεχίσετε. 

Το όνομα του φακέλου στο οποίο θα εγκατασταθεί το Octave ΔΕΝ επιτρέπεται να έχει 

κενό (space) χαρακτήρα. Αντί αυτού μπορεί να χρησιμοποιηθεί το _ ή το - . Συνεπώς δεν 

μπορεί να εγκατασταθεί κάτω από τον φάκελο Program Files. 

Συνίσταται να χρησιμοποιηθεί ο προεπιλεγμένος φάκελος του Octave όπως φαίνεται 

παρακάτω. 

https://www.gnu.org/software/octave/
ftp://ftp.ntua.gr/mirror/gnu/octave/windows/


 

 

Όταν ολοκληρωθεί η εγκατάσταση εμφανίζεται το παρακάτω παράθυρο.  

 



Πατώντας Finish εμφανίζεται στον browser μια ενημερωτική σελίδα και ταυτόχρονα ξεκινά η εκτέλεση του Octave. 

Ταυτόχρονα, στην επιφάνεια εργασίας έχουν προστεθεί δύο εικονίδια 

 

Για την εκκίνηση του Octave σε γραφικό περιβάλλον (Graphical User Interface – GUI) επιλέγεται το δεύτερο εικονίδιο, 

Octave-4.2.1 (GUI). 

 

 

2 Το περιβάλλον εργασίας Octave 

2.1 Εκκίνηση 

Το Octave εκκινεί πατώντας το εικονίδιο  στην επιφάνεια εργασίας ή αναζητώντας το Octave στην Έναρξη των 

Windows. Την πρώτη φορά που θα εκτελεστεί το πρόγραμμα εμφανίζεται το παρακάτω παράθυρο 

 

Το Octave διατίθεται και σε portable μορφή. Αντί για τον installer που κατεβάσατε 

παραπάνω, μπορείτε να κατεβάσετε το αντίστοιχο .ZIP αρχείο (π.χ. το octave-4.2.1-

w32.zip ή το octave-4.2.1-w64.zip) το οποίο αφού κατέβει στον υπολογιστή πρέπει να 

αποσυμπιεστεί σε κάποιον φάκελο και είναι έτοιμο προς εκτέλεση. Με αυτό τον τρόπο 

το Octave μπορεί να εκτελεστεί ακόμη κι από USB stick. 

 



 

Στο επόμενο παράθυρο δίνεται η δυνατότητα να επιλέξει κανείς εάν θα συνδέεται το Octave στην ιστοσελίδα του 

προγράμματος ώστε να εμφανίζει νέα και ειδήσεις σχετικά με το Octave και τις τελευταίες του εκδόσεις.  

 



Στην συνέχεια με Next και Finish  ξεκινά η εκτέλεση του Octave. 

 

2.2 Ρύθμιση των παραθύρων εργασίας 

Το περιβάλλον εργασίας του Octave περιέχει διάφορα λειτουργικά παράθυρα που σκοπό έχουν να διευκολύνουν και 

να επιταχύνουν την ανάπτυξη των εφαρμογών. Μια πλήρης λίστα των διαφόρων παραθύρων καθώς και η 

δυνατότητα εμφάνισης/απόκρυψής τους υπάρχει στην καρτέλα Window. Η θέση των παραθύρων μπορεί να 

ρυθμιστεί κρατώντας τα από τον υπέρτιτλο τους και "σέρνοντας" τα (με κρατημένο του αριστερό πλήκτρο του 

ποντικιού) στην επιθυμητή θέση.  

 



Προκειμένου να υπάρχει ο μεγαλύτερος δυνατός χώρος για το γράψιμο των προγραμμάτων (παράθυρο Editor) 

καθώς και για την παρακολούθηση των αποτελεσμάτων (παράθυρο Command Window) , είναι σκόπιμο τα 

παράθυρα αυτά να έχουν ικανοποιητικό χώρο μέσα στο περιβάλλον εργασίας του Octave. Για παράδειγμα, 

επιλέγοντας στην καρτέλα Window μόνο τον Editor και το Command Window και στοιχίζοντας (με drag and drop 

από την επικεφαλίδα τους) τα παράθυρα με τον Editor αριστερά και το Command Window δεξιά, ο χώρος του 

Octave φαίνεται ως εξής: 

 

 

 

 

2.3 Καθορισμός τρέχοντος φακέλου 

Ο καθορισμός του τρέχοντος φακέλου στον οποίο θα αποθηκεύονται τα αρχεία .m που θα δημιουργούνται από το 

Octave γίνεται πατώντας το εικονίδιο . Αντί του προεπιλεγμένου φακέλου (C:\Users\%USERNAME%) μπορεί 

να επιλεγεί ένας άλλος φάκελος στον τοπικό δίσκο για παράδειγμα στον δίσκο D:\STUDENTS\15101, όπως 

φαίνεται παρακάτω:  

Η διάταξη των παραθύρων εργασίας μπορεί ανά πάσα στιγμή να επανέλθει στην 

προκαθορισμένη της μορφή επιλέγοντας Window->Reset Default Window Layout. 

 



 

Όταν ολοκληρωθεί η διαδικασία τότε στο Current Directory θα εμφανίζεται ο επιλεγμένος φάκελος: 

 

2.4 Επιλογή χρωμάτων για τον Editor 

Το Octave, όπως και το Matlab, παρέχει την δυνατότητα να επιλέξει ο χρήστης την γραμματοσειρά και τα χρώματα 

που θα χρησιμοποιούνται στον Editor. Η δυνατότητα χρωματισμού του κειμένου είναι ιδιαίτερα χρήσιμη καθώς 

δίνει την δυνατότητα στον χρήστη να βλέπει τμήματα του κώδικα με διαφορετικό χρώμα ανάλογα με το περιεχόμενό 

τους, π.χ. με την μορφή των εντολών, με το αν χρησιμοποιείται κάποια δεσμευμένη λέξη, με το αν έχει εισαχθεί 

κάποιο κείμενο κλπ. Οι προκαθορισμένες ρυθμίσεις για το χρώμα είναι στην καρτέλα Edit->Preferences->Edit 

styles. Πατώντας πάνω σε κάποιο χρώμα εμφανίζεται η καρτέλα επιλογής χρωμάτων που δίνει την δυνατότητα 

αλλαγής του επιλεγμένου χρώματος. Προκειμένου να συμβαδίζουν τα χρώματα του Octave με τα αντίστοιχα χρώματα 

που χρησιμοποιούνται στο Matlab προτείνεται να γίνουν οι εξής αλλαγές 



 

2.5 Γενικές ρυθμίσεις 

Στην καρτέλα Edit->Preferences υπάρχει μια πληθώρα επιλογών που καθορίζουν την συνολική λειτουργία του 

Octave. Μια σημαντική ρύθμιση που διευκολύνει την εκτέλεση των προγραμμάτων είναι στην καρτέλα Terminal η 

επιλογή Set focus to terminal when running a command from within another widget . Η επιλογή αυτή θα 

πρέπει να είναι ενεργοποιημένη ώστε κάθε φορά που εκτελείται κάποιο πρόγραμμα στον Editor να ενεργοποιείται 

το Command Window ώστε ο χρήστης να μπορεί να εισάγει τιμές ή/και δεδομένα κλπ χωρίς να χρειάζεται κάθε 

φορά να κάνει κλικ στο Command Window για να το ενεργοποιήσει. 

 



2.6 Επαναφορά αρχικών ρυθμίσεων 

Οι ρυθμίσεις που αφορούν το Octave σχετικά με την θέση του, τα παράθυρα, διάφορες παράμετροι λειτουργίας κλπ, 

αποθηκεύονται στο αρχείο C:\Users\<ΟΝΟΜΑ ΧΡΗΣΤΗ>\.config\octave\qt-settings. Μπορεί να 

γίνει επαναφορά των αρχικών ρυθμίσεων του Octave διαγράφοντας αυτό το αρχείο από τον δίσκο. Σε αυτή την 

περίπτωση το πρόγραμμα θα ξανατρέξει σαν να εκτελείτε πρώτη φορά, όπως περιγράφεται στην παράγραφο 2.1. 

2.7 Παράθυρο βοήθειας 

Το Octave παρέχει ένα παράθυρο βοήθειας το οποίο ενεργοποιείται γράφοντας την εντολή doc στο Command 

Window. Αυτό έχει ως αποτέλεσμα να εμφανιστεί το παράθυρο Documentation.  

 

 

 

Το παράθυρο του Documentation περιέχει πληροφορίες τόσο για το περιβάλλον εργασίας του Octave όσο και για 

τις διαθέσιμες εντολές και συναρτήσεις. Για την αναζήτηση βοήθειας για κάποια συγκεκριμένη εντολή μπορεί να 

χρησιμοποιηθεί η γραμμή στο κάτω μέρος του παραθύρου του Documentation. 

 

Το παράθυρο Documentation είναι πιο λειτουργικό εάν είναι "εκτός" χώρου του 

Octave (undocked). Για να "βγει" κάποιο παράθυρο εκτός του χώρου του Octave πρέπει 

να πατηθεί το εικονίδιο  (undock widget) στην άνω δεξιά γωνία. Ανά πάσα στιγμή 

μπορεί κάποιο παράθυρο να ξαναγίνει μέρος του Octave (dock widget) πατώντας το 

εικονίδιο . 

 



Ένας πιο πρακτικός τρόπος για αναζήτηση βοήθειας είναι απ' ευθείας στο Command Window γράφοντας doc 

ακολουθούμενο από την αναζητούμενη εντολή, π.χ. doc plot. Με τον τρόπο αυτό το Documentation θα 

εμφανίσει κατευθείαν την βοήθεια που αφορά την εντολή plot. 

 

2.8 Packages 

Το Octave συνοδεύεται από μια μεγάλη γκάμα packages που είναι το αντίστοιχο των toolboxes του Matlab. Τα 

packages παρέχουν επιπλέον εντολές και δυνατότητες για διάφορες επιστημονικές και θεματικές κατηγορίες. Για 

παράδειγμα, υπάρχουν packages για επεξεργασία εικόνας, στατιστική, επεξεργασία σήματος, γεωμετρία, άλγεβρα, 

οικονομικά κ.α. Η πλήρης λίστα των διαθέσιμων packages δίνεται στην ιστοσελίδα:  

http://octave.sourceforge.net/packages.php 

Ορισμένα από τα διαθέσιμα  packages παρέχονται ήδη με την εγκατάσταση του Octave.  Με την εντολή pkg list 

εμφανίζεται στο Command Window μια λίστα με τα packages που υπάρχουν εγκατεστημένα ήδη στο Octave. Για 

παράδειγμα: 

>> pkg list 

Package Name         | Version | Installation directory 

---------------------+---------+----------------------- 

     communications  |   1.2.1 | ...\octave\packages\communications-1.2.1 

            control  |   3.0.0 | ...\share\octave\packages\control-3.0.0 

     data-smoothing  |   1.3.0 | ...\octave\packages\data-smoothing-1.3.0 

           database  |   2.4.2 | ...\share\octave\packages\database-2.4.2 

          dataframe  |   1.1.0 | ...\share\octave\packages\dataframe-1.1.0 

              dicom  |   0.1.1 | ...\share\octave\packages\dicom-0.1.1 

          financial  |   0.5.0 | ...\share\octave\packages\financial-0.5.0 

               fits  |   1.0.7 | ...\share\octave\packages\fits-1.0.7 

fuzzy-logic-toolkit  |   0.4.5 | ...\octave\packages\fuzzy-logic-toolkit-0.4.5 

                 ga  |  0.10.0 | ...\share\octave\packages\ga-0.10.0 

            general  |   2.0.0 | ...\share\octave\packages\general-2.0.0 

      generate_html  |  0.1.13 | ...\octave\packages\generate_html-0.1.13 

           geometry  |   2.1.1 | ...\share\octave\packages\geometry-2.1.1 

http://octave.sourceforge.net/packages.php


                gsl  |   2.0.0 | ...\share\octave\packages\gsl-2.0.0 

              image  |   2.6.1 | ...\share\octave\packages\image-2.6.1 

 instrument-control  |   0.2.3 | ...\octave\packages\instrument-control-0.2.3 

           interval  |   2.1.0 | ...\share\octave\packages\interval-2.1.0 

                 io  |   2.4.5 | ...\OCTAVE~1.1\share\octave\packages\io-2.4.5 

     linear-algebra  |   2.2.2 | ...\octave\packages\linear-algebra-2.2.2 

               lssa  |   0.1.2 | ...\share\octave\packages\lssa-0.1.2 

              ltfat  |   2.2.0 | ...\share\octave\packages\ltfat-2.2.0 

            mapping  |   1.2.1 | ...\share\octave\packages\mapping-1.2.1 

      miscellaneous  |   1.2.1 | ...\share\octave\packages\miscellaneous-1.2.1 

                nan  |   3.1.2 | ...\share\octave\packages\nan-3.1.2 

             netcdf  |  1.0.11 | ...\share\octave\packages\netcdf-1.0.11 

              nurbs  |  1.3.10 | ...\share\octave\packages\nurbs-1.3.10 

                ocs  |   0.1.5 | ...\share\octave\packages\ocs-0.1.5 

             odepkg  |   0.8.5 | ...\share\octave\packages\odepkg-0.8.5 

              optim  |   1.5.2 | ...\share\octave\packages\optim-1.5.2 

         quaternion  |   2.4.0 | ...\share\octave\packages\quaternion-2.4.0 

           queueing  |   1.2.5 | ...\share\octave\packages\queueing-1.2.5 

             signal  |   1.3.2 | ...\share\octave\packages\signal-1.3.2 

            sockets  |   1.2.0 | ...\share\octave\packages\sockets-1.2.0 

          sparsersb  |   1.0.2 | ...\share\octave\packages\sparsersb-1.0.2 

            specfun  |   1.1.0 | ...\share\octave\packages\specfun-1.1.0 

            splines  |   1.3.2 | ...\share\octave\packages\splines-1.3.2 

         statistics  |   1.3.0 | ...\share\octave\packages\statistics-1.3.0 

                stk  |   2.3.4 | ...\share\octave\packages\stk-2.3.4 

            strings  |   1.2.0 | ...\share\octave\packages\strings-1.2.0 

             struct  |  1.0.14 | ...\share\octave\packages\struct-1.0.14 

             tisean  |   0.2.3 | ...\share\octave\packages\tisean-0.2.3 

                tsa  |   4.4.5 | ...\share\octave\packages\tsa-4.4.5 

              video  |   1.2.3 | ...\share\octave\packages\video-1.2.3 

            windows  |   1.2.4 | ...\share\octave\packages\windows-1.2.4 

             zeromq  |   1.2.1 | ...\share\octave\packages\zeromq-1.2.1 

>> 

 

 

2.8.1 Ενεργοποίηση ενός package 

Για να χρησιμοποιηθεί κάποιο package στο Octave θα πρέπει την πρώτη φορά να γίνει ενεργοποίησή του.  

Παράδειγμα 

Έστω ότι έχουμε γράψει στον Editor το πρόγραμμα που φαίνεται κάτω αριστερά. Το πρόγραμμα αυτό: 

- καθαρίζει το Command Window 

- σβήνει όλες τις μεταβλητές από την μνήμη 

- φορτώνει την εικόνα 'marbles.jpg' (που έχουμε ήδη τοποθετήσει στον τρέχοντα φάκελο) και  

- μειώνει τις διαστάσεις της εικόνας κατά 50% 

Στην τελευταία γραμμή, η εντολή imresize δεν είναι εντολή του βασικού Octave αλλά υπάρχει στο package image, 

το οποίο όπως φάνηκε στην παραπάνω λίστα είναι ήδη εγκατεστημένο στο Octave αλλά είναι απενεργοποιημένο. 

Ένα σχετικό μήνυμα εμφανίζεται παρακάτω στο Command Window στα δεξιά όπου μας ενημερώνει ότι για να 

ενεργοποιήσουμε το package αυτό θα πρέπει να δώσουμε στο Command Window την εντολή 

>> pkg load image 

 

 



 

a

 

Δίνοντας την εντολή αυτή στο Command Window, ενεργοποιείται το package το πρόγραμμα έπειτα εκτελείται 

κανονικά. 

2.8.2 Πληροφορίες σχετικά με κάποιο package 

Για να δει κανείς περισσότερες λεπτομέρειες σχετικά με κάποιο από τα εγκατεστημένα packages μπορεί να 

χρησιμοποιήσει την εντολή pkg describe. Για παράδειγμα, η εντολή: 

>> pkg describe image -verbose 

Παρέχει πληροφορίες σχετικά με το package image το οποίο περιέχει μια βιβλιοθήκη εντολών επεξεργασίας εικόνας. 

Συγκεκριμένα, εμφανίζονται η version του package που είναι εγκατεστημένο, μια σύντομη περιγραφή καθώς και η 

λίστα των εντολών που περιέχει. 

 

>> pkg describe image -verbose 

--- 

Package name: 

        image 

Version: 

        2.6.1 

Short description: 

        The Octave-forge Image package provides functions for  pro 

cessing images.  The package also provides functions for feature e 

xtraction, image  statistics, spatial and geometric transformation 

s, morphological  operations, linear filtering, and much more. 



Status: 

        Loaded 

--- 

Provides: 

Analysis and Statistics 

        corr2 

        edge 

        fftconv2 

        fftconvn 

        mean2 

        std2 

        entropy 

        entropyfilt 

        qtdecomp 

        qtgetblk 

        qtsetblk 

        graycomatrix 

        houghtf 

        hough_line 

        hough_circle 

        imgradient 

        imgradientxy 

        imhist 

        immaximas 

        immse 

        normxcorr2 

        psnr 

        rangefilt 

        regionprops 

        stdfilt 

Arithmetics 

        imabsdiff 

        imadd 

        imcomplement 

        imdivide 

        imlincomb 

        immultiply 

        imsubtract 

Black and white image functions 

        applylut 

        bwarea 

        bwareafilt 

        bwboundaries 

        bwconncomp 

        bwdist 

        bweuler 

        bwfill 

        bwhitmiss 

        bwlabel 

        bwlabeln 

        bwmorph 

        bwperim 

        bwpropfilt 

        bwselect 

        fchcode 

        labelmatrix 

        makelut 

Colour maps and Colour controls 

        colorgradient 

        rgb2ycbcr 

        wavelength2rgb 

        ycbcr2rgb 

Display 

        montage 

        subimage 

Enhancement and Restoration 

        histeq 



        imadjust 

        imnoise 

        imsmooth 

        medfilt2 

        ordfilt2 

        ordfiltn 

        stretchlim 

Filtering and Transforms 

        findbounds 

        fspecial 

        imfilter 

        imtransform 

        intlut 

        iradon 

        nonmax_supress 

        radon 

        rho_filter 

Morhophological Operations 

        bwareaopen 

        conndef 

        imbothat 

        imclearborder 

        imclose 

        imdilate 

        imerode 

        imfill 

        imopen 

        imreconstruct 

        imregionalmax 

        imregionalmin 

        imtophat 

        mmgradm 

        @strel/getheight 

        @strel/getneighbors 

        @strel/getnhood 

        @strel/getsequence 

        @strel/isflat 

        @strel/reflect 

        @strel/strel 

        @strel/translate 

        watershed 

Read/write 

        analyze75info 

        analyze75read 

        analyze75write 

        tiff_tag_read 

Region-based and block processing 

        bestblk 

        blockproc 

        col2im 

        colfilt 

        im2col 

        impixel 

        nlfilter 

        poly2mask 

        roicolor 

Spatial transformations 

        cp2tform 

        imcrop 

        imperspectivewarp 

        impyramid 

        imremap 

        imresize 

        imrotate 

        imshear 

        imtranslate 

        maketform 



        rotate_scale 

        tformfwd 

        tforminv 

Types and Type conversions 

        grayslice 

        graythresh 

        im2bw 

        im2double 

        im2int16 

        im2single 

        im2uint8 

        im2uint16 

        imcast 

        imdither 

        imquantize 

        isbw 

        isgray 

        isind 

        isrgb 

        lab2double 

        lab2rgb 

        lab2single 

        lab2uint16 

        lab2uint8 

        lab2xyz 

        label2rgb 

        mat2gray 

        rgb2gray 

        rgb2lab 

        rgb2xyz 

        xyz2lab 

        xyz2rgb 

Utilities 

        checkerboard 

        edgetaper 

        getrangefromclass 

        imattributes 

        imgetfile 

        iptcheckconn 

        iptcheckmap 

        iptnum2ordinal 

        otf2psf 

        padarray 

        phantom 

        psf2otf 

 


